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Résumé:

Le polycopié "Calcul Assisté par Ordinateur avec le logiciel ETABS" s'adresse aux étudiants en 3eme
année licence Génie Civil. Il vise & familiariser les étudiants avec les logiciels de calcul en génie civil et a
leur apprendre & dimensionner les éléments d'une structure soumise a plusieurs sollicitations. Il est
important pour les étudiants de comprendre les caractéristiques essentielles d'un logiciel de calcul, de
maitriser son interface, de saisir correctement les données et de récupérer les résultats nécessaires. Les
prérequis recommandés sont les cours d'informatique 1 et 2. Les premiers travaux pratiques aideront les
étudiants a comprendre les bases des logiciels de calcul, les différentes méthodes utilisées, les logiciels
fermés et ouverts, ainsi que les avantages et limites. lls utiliseront notamment ETABS pour apprendre
I'interface, le travail avec les données, les options, les résultats et I'interprétation, avant d'analyser un
projet concret.

Mots clés : Calcul Assisté par Ordinateur, Etabs, logiciels de calcul, interface

Abstract :

The handout ‘Computer-aided calculation with ETABS software’ is intended for students of 3rd year
bechelor Civil Engineering. It aims to familiarise students with civil engineering calculation software and
to teach them how to dimension the elements of a structure subject to several stresses. It is important for
students to understand the essential features of calculation software, to master its interface, to enter data
correctly and to retrieve the necessary results. The recommended prerequisites are Computer Science 1
and 2. The first practical exercises will help students to understand the basics of calculation software, the
different methods used, closed and open software, as well as the advantages and limitations. Students
will use ETABS to learn about the interface, working with data, options, results and interpretation, before
analysing a concrete project.

Key words: Computer-aided calculation, Etabs, interface
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INTRODUCTION GENERALE

Le présent polycopié intitulé Calcul Assisté par Ordinateur «Calcul Assisté par
Ordinateur avec le logiciel ETABSy, s’adresse aux étudiants de troisiéme année LMD en
Génie Civil. Il met ’accent sur le dimensionnement des éléments d’une structure soumise
a plusieurs sollicitations.

Objectifs de I'enseignement consiste a familiariser les étudiants avec les logiciels de
calcul utilisés en genie civil. Il est nécessaire pour l'étudiant de comprendre les
caractéristiques essentielles d'un logiciel de calcul, en se basant sur un projet existant, et
de maitriser l'interface du logiciel, de saisir correctement les données et de récupérer les
résultats demandés. Recommandations de connaissances préalables : 1 et 2 Informatique
et informatique

Au cours des premiers travaux pratiques, les étudiants acquerront les concepts
fondamentaux des logiciels de calcul, ainsi que le fonctionnement et les méthodes de
calcul utilises. Ils étudieront les logiciels fermés, les logiciels ouverts, ainsi que les
avantages et les limites des logiciels. Ensuite, arrive I'étape de la L'utilisation d'un
logiciel disponible (comme ETABS) implique la présentation de linterface, de
I'environnement de travail, des données, des options, des résultats (numériques et
graphiques), ainsi que l'interprétation. Et enfin, I'analyse et le suivi d'un projet concret.



1.

Introduction

La conception assistée par ordinateur ou CAO (en anglais, computer aided design ou
CAD) comprend l'ensemble des logiciels et des techniques de modélisation géométrique
permettant de concevoir, de tester virtuellement — & I'aide d'un ordinateur et des
techniques de simulation numérique —

ETABS est 1’un des logiciels de calcul congu exclusivement pour le calcul des batiments.
Il permet de modéliser facilement et rapidement tous types de batiments grace a une
interface graphique unique. Il offre de nombreuses possibilités pour 1’analyse statique et
dynamique. Ce logiciel permet la prise en compte des propriétés non-linéaires des
matériaux, ainsi que le calcul et le dimensionnement des éléments structuraux suivant
différentes réglementations en vigueur a travers le monde (Euro code, UBC, ACI..etc).

2. Concept de base sur les logiciels de calcul CAO

La Conception Assistée par Ordinateur (CAO) est I’ensemble des outils logiciels et des
techniques informatiques qui permettent d’assister les concepteurs dans la conception et la

mise au point d’un produit.

2.1. Definition du logiciel de calcul ETABS
ETABS est I’abréviation de «Extented Three Dimentional Analysis of Building

Systems», ¢’est un logiciel intégré ultime pour I’analyse structurelle et la conception de
batiments. Il offre des outils de modélisation et de visualisation 3Dinégalés, une puissance
analytique linéaire et non linéaire incroyablement rapide, des capacités de conception
sophistiquées et complétes pour une large gamme de matériaux, et des affichages
graphiques, des rapports, et des dessins schématiquesqui permettent aux utilisateurs de
déchiffrer et de comprendre rapidement et facilement les résultats de 1’analyse et de la

conception.

De plus de part ca speécificité pour le calcul des batiments, ETABS offre un avantage
certain par rapport au codes de calcul a utilisation plus étendue. En effet, grace a ces
diverses fonctions il permet une décente de charge automatique et rapide, un calcul
automatique du centre de masse et de rigidité, ainsi que la prise en compte implicite
d’une éventuelle excentricité accidentelle. Il permet également le transfert de donnée
avec d’autres logiciels (AUTOCAD,SAP2000 et SAFE).

2.2 .Modélisation
Le but de la modélisation est de développer des modeles capables de décrire



approximativement le comportement d'une structure dans différentes conditions.

Actuellement, il existe un certain nombre de programmes basés sur la méthode des
éléments finis (FEM) qui permettent le calcul automatique de diverses structures.

Les ingenieurs peuvent donc ignorer le principe MEF. Il suffit de savoir utiliser le
programme de calcul et de connaitre la réglementation applicable. Cet utilisateur ne peut

cependant pas modifier les résultats fournis par I'ordinateur.

Par conséquent, il est essentiel que tous les ingénieurs comprennent les bases de la FEA et
comprennent le processus de la phase de résolution. Cette compétence ne peut étre acquise
que par I'étude analytique des concepts MEF et la connaissance des techniques associées a

I'utilisation de ces outils informatiques.

3. Etapes de modélisation

1. Initialiser le modele (unités, grilles, niveaux).

2. Définir les paramétres de I’analyse (matériaux, sections, cas et combinaisonsde
chargements)

3. Modéliser la structure
5. Appliquer les charges statiques
6. Chargement dynamique

7. Analyse et exploitation des résultats (visualisation graphique, tableaux,
exportation des résultats)

8. Ferraillage.
Solution :
1. Choisir le type d’analyse (statique, dynamique...)
2. Construire la matrice et le vecteur élémentaire [ ] ,{fe }
3. Assembler [ ] et { } dans [K] et {F}
4, Prendre en compte les conditions aux limites
5. Résoudre le systeme d’équations [K] {U}={F}
6. Calculer les variations additionnelles (réactions, o, €...)
Post-procession:
1. Présenter les résultats sous forme numérique ou graphique
2. Effectuer des fonctions complémentaires : combinaisons, interpolations, animation ...

Description de l'outil ETABS : Le programme ETABS (Extended Three-dimensional
Analysis of Building Systems) est un logiciel leader en ingénierie des structures, créé en
1984 et edité par Computers & Structures Inc. Ce logiciel est fréquemment utilisé par les
ingénieurs civils pour le calcul tridimensionnel par éléments finis de batiments et des
ouvrages de génie civil.

Les principales raisons d'utilisation de ce programme comme un outil de calcul de structures,
sont qu'il est utilisé pour analyser les structures en béton armé, charpente métallique ou
autres matériaux de construction et sous n'importe quelle forme de chargement (ponctuel,
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linéaire, surfacique... etc.).
Le logiciel traite plusieurs types de chargement statique (poids propre de la structure et
charges d'exploitation) ou dynamique (séisme).

BOUTONS DES FICHIERS:

1. Créer un nouveau modele. ~
2. Ouvrir un modeéle existant. D= & © l % g
3. Enregistrer un modeéle dans un fichier. 1 2 3 4 5 6 7 8
4. Annuler une action. Figure 1: boutons des fichiers
5. Reprendre une action. -
6. Refranchir la fenétre.
7. Verrouiller le modéle apres I’analyse.
8. Lancer les calculs.
BOUTONS D’AFFICHAGE:
PDO®PO®PO M| 3drR e 26| & &%
01 02 03 04 05 06 07 08 09 10 11 12 13 14 15
Figure 2: boutons d’affichage
1. Zoom fenétre.
2. Zoom étendu.
3. Zoom précédent.
4. Zoom avant.
5. Zoom arriere.
6. Panoramique dynamique : sert a déplacer la vue de dessin.
7. Permet I’affichage de notre structure en trois dimensions.
8. Affichage du plan XY.
9. Affichage de I’¢lévation selon XZ Ou YZ.
10. Manipule la vue de la structure.
11. Offre la perspective de notre structure.
12. Changer la vue 2D (plan ou élévation) vers le haut.
13. Changer la vue 2D (plan ou élévation) vers le bas.
14. Rétrécir les éléments de model visuellement.
15. Définir les options de vue du la structure.



BOUTONS DE DESSIN:
BRRX = \NNZEN UOGEH==H<T
01 02 03 04 05 06 07 08 09 10 11 1213 14 15
Figure 3: Boutons de dessin
1. Pointeur utilisé pour une sélection d'un élément en cliquant dessus ou par une
fenétre desélection.
Editeur d’objet.
Créer un point.
Dessiner un élément unidimensionnel (Poutre ou poteau) (Plan, Elev, 3D)
Créer des éléments unidimensionnels par un clic (Plan, Elev, 3D)
Creéer des poteaux par un clic (Plan)
Creéer des poutres secondaires par un clic (Plan)
Creer des contreventements par un clic (Elev)
Dessiner des éléments bidimensionnels (Plan, Elev, 3D)
. Dessiner des éléments bidimensionnels de forme rectangulaires (plan, élévation)
. Créer des éléments bidimensionnels par un clic (Plan, Elev)
. Dessiner des murs (plan)
. Créer des murs par un clic (Plan)
14. Créer des fenétres dans les voiles (Elev)
15. Créer des portes dans des voiles (Elev)

W oo Nl ke WN
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4. Exemple :
Modélisation d’une Structure béton armée en R+7 a usage habitation.La

hauteur de tous les niveaux est : 3.06m

Figure 4: Exemple de modélisation des structures

Sections :

1 Poutres Principale : 35x30 cm
Poutres secondaire : 30x30 cm
Poteaux : 30x30 cm (6eme étage & Terrasse)
Poteaux : 35x35 cm (4eme étage & 5eme étage)
Poteaux : 40x40 cm (2eme étage & 3eme étage)
Poteaux : 45x45 cm (RDC & leme étage)
Planchers en Corps Creux 16+4 : 20 cm
1 Voile de contreventement : 15cm
1 Mur : 25 cm
Matériau :
[1 Béton : Fcog = 25MPa ; E=32164MPa ; p = 23500 kg/m3
1 Acier : FeE400 (longitudinales) ; FeE215 (Transversales)
Charges :
Charge permanente :
- Getage: 5.16 KN/m2
— Grerrasse = 6.10 KN/m?
Charge d’exploitation :
— Qetage = 1.50 kKN/m?
- QTerrasse: 1.00 kKN/mz2

U
U
H
H
H
H




4.1. Initialisation du modéle

Figure 5: Démarrer le programme et changer les unités par défaut en (kn-
Fi¢™) défaut en (kn-m)

4.2. Commencer un nouveau modele (File _ New model) :

M ETAB
File
I D) New Model CtrleN I
& Upen o0
1 o
Mew Model Initialization
mport

Do you want ta initislize your new model with definitions and

preferences from an existing %b file? [Press F1 Key for help.)

Choose .edb

Display Input/Output Text Eiles

Delete Analysis Files

Figure 6: Nouveau modeéle




4.3. Définir la grille horizontale (Custom grid spacing , Edit Grid) :

s Define Grid Data x

Edit Format 6
Grid Dimensions (Plan] Story Dimensions 2

Bubble Size  |1.25

Reset to Default Color

SteelDeck  Staggered Flat Slab FlatSlabwith  WalfleSlab  TwowWayor  Grid Only
Tiuss Perimeter Beams Ribbed Slab

R Grid Data
" Uriform Grid Spacing " Simple Story D ata Grid 1D Spacing | Line Type | Visibiity | Bubble Loc. | Grid Colar &
] 1 A 35 Primary Show Top
Mumber Lines in ¥, Direction | |4 Mumber of Stories 8 2 B 3 Primary Show Tap
. . 3 C 35 Primary Show Top B
Mumber Lings in'y' Direction | |3 Typical Story Height 3,06 4 o 0 Primary Show Tor
8
Spacing in % Direction 6 Buottom Stary Height 3,06 s
7
3 Spacing in ¥ Direction E. (" Custom Story Data e
a
@Eustnm Girid Spacing 4 e 10 | Urits
. I KN-m hd
GidLabels.. | EdiGid.. | | Pl voidnas
GridlD | Spacing || Line Typs | Visbity | Bubbleloc | Giid Color = Display Grids as 5
A Stuctrsl Objects o 45 | Pimay | Shw | Let - Drdinate@pamng
2 2 45 Primary Show Left
T T h ” i e : j 3 0 Primary Show Lett B e
T T I i 0 E G & mn bl 5 ™ Glue to Grid Lines
T—Hu—1 oo - &
7
| 8 |
|8 |

E
5

Cancel 0K Cancel
v

Figure 7:Définition des grilles

4.4. Entrer les distance des travées apres avoir sélectionné I’option (Spacing)

4.5. Spécifier le nom et la hauteur des étages et Grouper les niveaux similaires(Assigner
la similarité aux 7 premiers niveaux) :

TERRASSE - MASTER STORY _ NO
RDC - MASTER STORY _ YES

H-1ER & H-6EME _ Similar to RDC

Building Plan Grid System and Story Data Definition Story Data
Grid Dimensions (Plan] Qe Binzsis Label Heicht Elevalion | Masler Story | Simiar To || Splice Point_| Splice Height
9 | TERRASSE 308 24.48 Na MNOME Na 0
(™ Unitarm Grid Spacing " Simple Story Data ] H-GEME 306 21.42 Mo TERRASSE Mo 0
7 H-BEME 306 18.36 No TERRASSE No 0.
Mumber Lines in % Direction |4 Hurnber of Stories 2 3 H-4EME 306 153 No TERRASSE No 0
] H-3EME 308 12.24 Na TERRASSE Na 0
Murnber Lines in 'y Direction |3 Typical Stary Height 206 4 H-2EME 306 418 Mo TERRASSE No i
3 H-1ER 306 612 No TERRASSE No 0.
Spacing in % Directian [ 1 Battam Story Height 206 2 RODC 308 308 Yes No 0
1 BASE 0
Spacing inY Direction ’5—
P
(+ Custom Grid Spaci .
+ Custom Grid Spacing Urite J
GridLabeks.. | Edt Grid | K -
Add Stuctural Dbjects
Reset Selected Rows Urits:
I—H—TI —H— e T
| [ I i H Change U N
it 1 N E 0 = RN i Height 106 Fleset iange Urits i hd
T [
l_H_l l’l_ﬂ_u o o1 o : L Master Gty N2 Fieset
SteslDeck  Stagasred FlatSlab  FlatSlabwith  WalfleSlsb  TwoWayor  Grid Only SmiaTo  [NONE ] _Plese |
Truss Perimeter Beams Fiibbed Slab SpiceFaint [No 7 Resst
Sploe Height |0 Rieset Cancel
Cancel

Figure 8: spécification des étages et grouper les niveaux similaires



4.6. Commencer avec un modeéle vide (cliquer sur Grid only _ OK) :

L
Building Plan Grid System and Story Data Definition
Girid Dimensions [Flan] Stary Dimensians
" Uniform Grid Spacing " Simple Stary Data
Number Lines in Direction |4 Number of Stories B
Wumber Lines in'Y Dirsction |3 Typical Sty Height 308
Spacing in X Direction E. Biattarn Story Height 306
Spacing i’ Direction & & Custom Story Data | 7EBGHGT DA
I
Custom Giid Spacing rits
Grid Labels... | Edit Grid. | KN S
Add Structural Dbjects
—n—z | n—r—un
| | E p— §
SteelDeck  Staggered FlatSlab  FlatSlabwith  ‘WaffleSlab  TwoWeyor  Grid Only
Tuss Perimeter Beams Fiibbed Slab
oK Cancel

Figure 9 : modele vide

4.7. Changer le reglement par défaut :

Options  Help

3 I

Colors
Windows

Set Calculator Mermory...

« Show Tips at Startup

+ Show Bounding Plane

+ Moment Diagrams on Tension Side

+ Sound

& Lock Model
Auto Save Model...

Show Aerial View Window
~ Show Floating Property Window

Show Crosshairs
+ Enhanced Graphics...

Reset Toclbars

Dimensions/Tolerances...

r Qutput Decimals... il _
1 Concrete Frame Design Preferences
E) sp
ncrete Frame Design., - 2
. . Design Code EUROCODE 2-1932
P = e Mumber of Interaction Curves )

Shear Wall Design... Mumber of Interaction Paints 11
Consider Mininum Eccentricity Yes

Reinforcement Bar Sizes... MNu 0.0l

Live Load Reduction... Gamma [Steel] 115
Gamma [Conciete] 15
Fattern Live Load Factor 075
Utilization Factor Limit 0.95

Cancel

Figure 10: réglement par défaut




4.8. Définition des parametres du modele
Définition des propriétés de matériaux :

On définit les propriétés des matériaux avec Define > Material Properties. Visualisation des
systemes de coordonnées local :

Les systemes de coordonnées local des éléments de barre peuvent étre visualisés avec la
commande de menu View > Set Building View Options, dans le panneau Object View
Options de la boite de dialogue Set Building View Options, on coche ’option Line Local
Axes.

Les systemes de coordonnées local des éléments de plaque peuvent étre visualisés en utilisant
la commande de menu View > Set Building View Options, dans le panneau Object View
Options de la boite de dialogue Set Building View Options, on coche 1’option Area Local
Axes.
Définition des propriétés de la section:

La définition d’une section de barre s’effectue avec la commande de menue Define > Frame
Sections. Dans la boite de dialogue Define Frame Section, on choisit le type de section dans la
boite a liste déroulante Add.

Pour importer une section d’un tel fichier on utilise la commande de menu Define > Frame
Sections. dans la boite de dialogue Define Frame Sections, on choisit le type de section dans
la boite a liste déroulante Import.

Pour définir un type de section de plaque, on utilise la commande de menu Define >
Wall/Slab/Deck Sections et dans la boite de dialogue Define Shell Sections, qui apparait, on
clique sur la boite a liste déroulante Add New ... et on choisit le type de section désire.

4.8.1. Définir les matériaux (Define _ Material properties) :

% Wall/Slab/Deck Sections... 1 =
an View - N Link Properties...

Frame Nonlinear Hinge Properties...

Define Materials

M aterials 2 Click to: 3
|
|
|

Diaphragms...

Section Cuts... Add Mew Material ..

&
E Response Spectrum Functions... STEEL Modify/Show Material...
@ Time History Functions...

DEL Static Load Cases...
Static Monlinear/Pushover Cases...
Cancel

Add Seguential Construction Case

PE’L Load Combinations...
Add Default Design Combos...

Special Seismic Load Effects...

@7 Mass Source..

Figure 11: Définition des matériaux



4.8.2. Modifier le matériau BETON par les propriétés suivantes (Ei=32164 Mpa;poids
volumique 25kN/m3)

Material Property Data
Dizplay Color
Material Hame BETOM Color
Type of Material Type of Design
{* |sotropic " Orthatropic Dresign Concrete
Analyzsiz Property Data Dezsign Property Data (EUROCODE 2-1992)
Mass per unit Volume 25h Charact. Conc Cyl Strength, fck 25000
Weight per unit Yolume 25 Bending Reinf. *ield Stress, fuk 400000
Modulus of Elasticity 32164000 Shear Reinf. vield Stress, ik 215000
Poizzon’s Ratio 0.z [ Lightweight Concrete
Coeff of Themal Expansion 9.900E-08 Shear Strength Reduc. Factar
Shear Modulus 103421368
Ok, I Cancel

Figure 12: Modifier le matériau BETON
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Define Draw  Select  Assign

Analyze

v

N N Link Properties...

Frame Monlinear Hinge Properties...

Define Frame Properties

-’ Properties

Type in property to find:
444335

Click to:
Impoit | /wfide Flange -
Add | /wide Flange b

£dd Double Angle

4.8.3. Définir les sections des poutres et des poteaux (Define _Frame sections) :

Add Bos/Tube
g

Diaphragms...
tanogular
Add General
Add Steel Joist
Section Cuts... Add Auto Select List v
——

E Response Spectrum Functions...
W Time History Functions...

Cancel

DEL Static Load Caszes...

Reinforcement Data

3 Design Type 6 b

Rectangular Section

Sta

Ad Section Name | GECES | " Column @Baam L
! L

B | o Properties Property Modifisrs M 2t — Concrets Cover to Rebar Cente
Ad Section Propertiss... | Set Modifiers... ‘ BETON x 4 Top 0.03 B

Dimensions 1 Battom L]
Spd Depth [13] 0.3 [T L
’03— L& & & Reinforcement Overides for Ductile Beams 1
ap Maff|  WEh (2] Lett Right H
5 e el I e

e = e Bottom |0 0 ’

===
Concrete ‘ > i)
Reinforcemert..
__Reinfrcenent.,_| Display Color ||

Cancel

Figure 13 : Définir les sections des poutres et des poteaux

Cancel I

Remarque : le paramétre « Concrete Cover to Rebar center » c’est la distance entre
le coffrage et le centre des armatures, et c’est ce qu’on appelle ’enrobage des
armatures, ce dernier a pour but de protéger les armaturescontre les intempéries.

4.8.4. Commencer par définir les sections des poutres principales et secondaires
4.8.5. Puis definir les sections des poteaux :

Reinforcement Data
Desiggype
Rectangular Section Por
i " Beam
G D iPDTanan I Configuration of B einfarcerment
" Rectangular " Circular
Properties Property Modifiers Mater
Section Properties... | Set Modifiers... | Lateral Reinforcement
Dimensions o Ties i
Depth [t3] 0.3 | L ‘
WD (6B o — e & Rectangular Reinforcement Y
3 . Caver to Rebar Center 0.04
I
. e ® Murnber of B ars in 3-dir 3
I I I Murmber of B ars in 2-dir 3
Concrete
Reinforcement Display Color — Bar Size #3 -
T Corner Bar Size H3 -
Checlk./Design
i~ Reinforcement ta be Checked
@ Fieinforcement to be Designed
7 Ok, I Cancel
Figure 14: définir les sections
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Remarque 01 : on peut choisir entre une section du poteau rectangulaire oubien
circulaire sur la fenétre « Reinforcement Data » (Données du ferraillage), on
peut également choisir le type des armatures transversales

«Lateral Reinforcement » entre les cadres « Ties » ou bien les cerces

« Spiral »).

On choisit I’option « Reinforcement to be Designed » pour laisser le logiciel
calcule la section des armatures correspondante.

Remarque 02 : On peut également definir une section spécifique a 1’aide dela

fenétre « Section Designer », soit une poutre en béton armée sous forme de (1) :

Define Draw  Select  Assign  Analyze

£ _Material Properties...

Elame Sections... |

s Wall/Slab/Deck Sections...
| N Link Properties...

Frame Nonlinear Hinge Properties...

Diaphragms...

Section Cuts...

E Response Spectrum Functions...
Time History Functions...

DE" Static Load Caszes...
[~] Response Spectrum Cases...

Static Menlinear/Pushover Cases..,

Add Seguential Construction Case

PE’L Load Compbinations...
Add Default Design Combos...

Convert Combos to Nonlinear Cases...

Special Seismic Load Effects...

Define Fra

Froperties

Type in property to find:

CH30-30

Click ta:

Import 1 Afide Flange -
Add Rectangular -
~

Add Fipe
Add Rectangular
Add Circle

Add General
Add Steel Joist

@¥ Mass Source...

4.8.6.

Figure 15: Frame Section

Figure 16: Section Designer

12

5D Section Data

3

POUTRE

Section Name

EETON  Jhd

Base Material

Dezign Type
{+ Ma Check/Design
~

" Concrete Column

Section Designer.

Display Colar .

Cancel

Lok |

PUls on va avolr la tenetre « Section besigner » CI-dessous :




Pour créer une section il suffit juste de choisir la forme correspondante dansles
outils de dessin (exemple poutre en (1)) :

I ;Cii View Draw Select Display Options Help B : )
File Edit View Draw Select Display Of %i‘_‘ﬂ sleppplual |
B| =~ 7] 2le|e(2loll F
& | &
Y = —> H |
I 1 HEtrEw e [&] = & p) i
[ Elaagy :
| = Cliquer sur le plan pour X
", = dessiner la section
/' %ﬂy ¥=-063 ¥Y=030 KMN-m - Done

Figure 17: Section Designer a

Nous pouvons maintenant modifier les parametres de la forme en cliquantdessus
avec le bouton droit de la souris :

I

File Edit View Draw Select Display Options Help

B| o] 7] o|o|2|0l0m @[]

3

E Shape Properties - |/Wide Flange]
T Type USER, DEFINED

ﬁ Materl -1l 2

5

el ¥ g

L Height 0.45

- Top Width 0.4

— Top Thick 0.05

\w/eb Thick 0.05

= Bt width [iE]

— 1 Bot Thick 0.05

Ratation 0.

M| Cliquer sur le bouton /"= e

0 i : == >
+ droit de la souris sur la

B forme 3

4

1 Areas Selected ®=-101 Y=083 KMN-m hd Done

Figure 18: Section Designer b

On va avoir une forme comme celle-ci :

CsisD - m] b ‘
Edit View Draw Select Display Options Help ‘

ol| ¢| o[elele|o(m| m:|-| SectionName  [FOUTRE—

1 | Y Bage Material BETOM hd

Design Type i
+ Mo Check/Design

T

" Concrete Column

Ol
o

Diefine/Edit/Show S ection

Section Designer...

2 3 Digplay Color - ‘

= t|EE[EE MAE H=le 7 -

N
Y

£
=

Cancel

i

X=045 ¥ =025 KM-m Done

B
@
a
2

Figure 19: Section Designer c
13



Remarque : On peut ajouter des armatures sur la section soit automatiquement
(sur la fenétre des parameétres de la section) ou bien manuellement a partir de la
commande « Ferraillage ».

4.8.6. Définir la section du plancher (Define Wall/Slab/Deck Sections...) :

1
Define Draw  Select  Assign  Analyze
§ V& Material Properties... 1
L Sections Click. to: 2
-I k24 Wall/Slab/Deck Sections... WallfSlab Section 3 £1dd Mew Slab -
= kw LINK Properies... §
3 Nonli Hi P . I odify/Show Section...
rame MNonlinear Hinge Properties... Section Name o0
Diaphragms...
Material BETON h
Section Cuts...
— Ok,
E - e — Thickness
E5pOnse spectrum Functions...
0.z Cancel
@ Time History Functions... Weenee ﬂ
Bending 0z
DE" Static Load Cases...
Type

" Shel @ Membrane " Plate
Static Nonlinear/Pushover Cases... r
Add Seguential Construction Case Load Distribution
%’L Load Combinations... Llse Special One-way Load Distribution
Add Default Design Combaes.., 5
Digplay Color .

Special Seismic Load Effects... 6
oK Cancel

@7 Mass Source.

Figure 20: Définir la section du plancher
Remarque . la secuon « 1 nickness » signitie 1" epaisseur ae 1 eiement(aalie, plancher,

voile...) dans les 2 cas de sollicitation et de déformation :

— Membrane (Membrane) : c’est un élément qui travaille a la traction oubien a la compression
dans le plan seulement.

— Bending (Flexion) : ¢’est un élément qui travaille a la flexion.

4.8.7. Définir les sections des voiles (Define _ Wall/Slab/Deck Sections...) :

— Click to:

2 Add Mew Wall -
Section Name Y15 / Modify/Show Section...

Wall/5lab Section

Material EETON A
Thickness
Membrane 015
Cancel
Bending 0.15

Type 3

@Shel\ " Membrane " Plate
I Thick Plate

Load Distribution
™ Use Special One-w ap Load Distribution

Set Madifiers Display Calor .
Cancel

Figure 21: Définir les sections des voiles

14



4.8.7. Définir les cas de chargement (Define _ Static Load Cases...)Charge permanente G
Charge D’exploitation Q

4.8.7.1. Ajouter le poids des éléments structuraux a la charge permanente

Define  Draw  Select  Assign  Apalyze
ﬁ &, Material Properties...

T Frame Sections... 1
- Define Static Load Case Names
= % Wall/Slab/Deck Sections...

| | x Link Properties... Loads Click Te:
= = = Self weight Ao
Frame Nonlinear Hinge Properties... T i g LateraILnad Add New Load
Diaphragms... |Lve J I Madity Load

Section Cuts... 2 Delete Load
E Response Spectrum Functions... 1

@ Time Histery Functions...
C. |
T ==

Static Nonlinear/Pushover Cases...

T R e o

Figure 22: Définir les cas de chargement

4.8.8. Définir les combinaisons de charges (Define _ Load Combinations O
Add New Combo) :

exemple :ELU=1,35G +15Q; ELS=G+Q

Define  Draw  Select Assign  Analyze Load Combination Data Load Combination Data
§ I Material Properties...
L Frame Sections... Z
2 S WallfSlab/Deck Sections... - ELL o
£ LaadlCopbination]None Load Combination Mame I|ELS
- % Link Properties...
Frame Nonlinear Hinge Properties...
Diaphragmes. Load Combination Type ADD hd L
=lephragms... Load Combination Type ADD -
Define Combination
Section Cuts... [ micm bl api le E st 3 Define Comnbination

5] Response Spectrum Functions... |Q Static Load ~|[5 Lokl [N S 5
#% Time History Functions.

5 Static Load 135 |0Staticload =1
% Static Load Cases.. & Static Load 1
tdodify
Static Nonlinear/Pushover Cases...

Delete
Add Seguential Construction Case 1
Delete
kil | oad Combinations...

Ok Cancel

Special Seismic Load Effects...

ok Cancel

Figure 23: Définir les combinaisons de charges

4.3. Modélisation de la structure
4.3.1. Sélectionner la vue en plan de la TERRASSE :

Options  Help
sdeilet e | e & [23@ %[0
g -l - <& |[Es =

Select Plan Level

Select

Figure 24: vue en plan de la TERRASSE



4.3.2. Modéliser les poutres principales et secondaires :

D i

Properties of Object

Type of Line J Erame
Froperty | PP30+35
Mornent Releases Conbinuous

Plan Offget Mormal 0.
Dirawing Control Type Mone <space bar>

ERERE

Figure 25: poutres principales et secondaires

4.3.3. Sélectionner toutes les poutres puis diviser les a I’intersection des lignes :

Figure 26: Diviser Les poutres

4.3.4. Modéliser les poteaux du niveau TERRASSE (30X30)cm :

Create Columns in Region or at Clicks (Plan)
| Properties of Object

Praperty | POT 30230
Moment Releases Lontinuous
Anale 0.

Flan Offset # 0.

N @

[ERERS

Figure 27: poteaux du niveau TERRASSE
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4.3.5. On modifie la section des poteaux des niveaux inferieur ultérieurement
4.3.6. Ajouter les planchers corps creux 20cm :

g
2]
=
H
W Properties of Object
e Property
. Local Axis

Figure 28: planchers corps creux

4.3.7. Pour bien visualiser les dalles suivre les étapes suivant :

[ [E]& oot |

Set Building View Options...

Set Building View Gptions

Wiew by Coloes of Dbject Presert in View- Dbject View Dpticns
R Fico faes s Latels
7 wallpoeal

I™ Lirks Pori)

[ Exinggon
ﬂwgﬂ-(ie@cher cetteun -

Figure 29: visualiser les dalles

Remarque : la fleche dans la dalle représente 1’orientation des poutrelles(le
sens de transmission des charges), elle doit étre paralléle au sens des chainages

(poutres secondaires).

Le sens porteur (poutres principales) est le sens du portique qui contient la plus
longue travée (Lmax), dans notre exemple le sens porteur est suivant I’axe Y.

17



4.3.8. Sélectionner tous les éléments du plancher TERRASSE et les copier dans les
niveaux au-dessous par la commande « Replicate » :

K ' PRARAPL M M tra| e WE B, | N
1] e TEMBEBEE L. NT @G0, |mTm2 NS

Replicate

Linear Fiadial ] Mdirrar
_Opliors.. |

Fieplicate on Staries

Options...

x|

Cancel

i

[~ Delete Original

Figure 30: Sélectionner tous les éléments du plancher

4.3.9. Modifier les sections des poteaux pour les 6 premiers niveaux :
4.3.10. Pour faciliter la sélection choisir la vue en élévation puis activer la vue en
perspective, changer I’orientation de la vue a I’aide du clavier (les fleches).

Figure 31: Modifier les sections des poteaux

18



4.3.11. Modéliser les voiles de contreventement avec « Fixed lenght » pour fixerla
longueur du voile a 1m :

_ properties Df ObJECt

Type of Area Fier

Property W15
| G LD E.I':'I.L j | KN -M Plan Offzet Mormal i}

Auto Pier/Spandrel IDs? Mo

Drawing Control Fized Length <L»
Fixed Length 1

A
L'..

Figure 32: modéliser le voiles de contreventement a

4.3.12. Sélectionner le neeud de départ et d’arriver du voile :

i FPoint B 3 L=3.50]

Type of drea Pier

Property V15 .
Plan Offset Homal 0 g Properties of Object [~]
Auto Pier/Spandrel IDs? Mo i

Drawing Contral Ficed Lengh <> Type of uea Piet

Fived Length 1 Froperty ViE

Plan Offset Nomal 1}

Auto Pier/Spandrel IDs? Mo

Drawing Control Mone <space bar»

Figure 33: nceud de départ et d’arriver

4.3.13. Refaire les mémes étapes pour tous les voiles qui restants, sachant
qu’ilfaut refaire I’option « Fixed lenght » pour chaque voile :

Figure 34: mémes étapes pour tous les voiles
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4.3.14, Mailler les voiles horizontalement et verticalement si nécessaire, dans
notre exemple on va mailler les voiles verticalement seulement parce quela
longueur du voile n’est pas trés importante (I’intervalle des mailles est

compris entre 0.80m et 1.10m environ)
4.3.15.  Tout d’abord sélectionner tous les voiles qui se ressembles vis-a-vis la
geometrie (dans notre cas on va les sélectionner tous) :

i | Select Assign Apalyze Display D Select Sections

Select 2

LCran

= onXYPlane | I —————

{ at Pointer/in Window -

N"?ﬁ Intersecting Line

va on XZ Plane Ok

3
Lok |

on ¥Z Plane Cancel
_Clear Al |

by Groups... 1
by Frame Sections

by Wall/5lab/Deck Sections...
Clear All

by Link Properties...

hw line Othiert Tune

Figure 35: sélectionner tous les voiles

4.3.16.  Aller vers le menu EDIT pour créer un maillage :

File | Edit View Define Draw Select  Assigr

[ =2 Undo Area Object Add Ctrl+Z
= 3
& cut Ctl+X |
K Copy Curl+C
L) 1
S X Delete SUPPR Mesh Selected Areas

Add te Model From Ternplate 3 Meshing Options
" Cookie Cut at Selected Line Objects [Horiz.)

i1l Replicate...
" Cookie Cut at Selected Points at D eqrees [Horiz.
o Edit Grid Data ’ o[
o = @ Mesh Quads/Triangles inta | |1 by |3 Areas

EH Edit Stary Data e 2(‘ Mesh Quads/ Triangles at
7 Edit Reference Planes... r 3
E Edit Reference Lines... r

-

&
- Vd 4 J
------ e —

I*I Mowve Points/Lines/Areas... / I
=7 Expand/Shrink Areas...

oo
5 Merge Areas

4 BT

Figure 36: créer un maillage
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4.3.17. Sélectionner et Encastrer toutes les nceuds de la base (Sélectionner One
story au coin inférieur droit de la fenétre pour ne pas appliquer 1’encastrement
dans tous les nceuds de la structure) :

1] 3-3\306\1" E| %0
> - ST |E .

=~

Select Plan Level

H-3EME

H-2EME
I|DneStnry L||I3LDEAL j|KN-m j H-TER 3 Cancel

Select
TERRASSE
H-EEME
H-5EME
HAAEME

Assign falyze Display Design Options Help

X o |

=
Aok D 1
-

peY| Restraints (Supports)... F

%w Paint Springs...
b g

H
a
@
+
e

Assign Restraints

Restraints in Global Directions

[v Tranglation ¥ [ FRotation about =

v Tranglation % [ FRotation about

-

Joint/Point Loads
Link Properties...
Additional Point Mass...

v Tranglation £ [ Fotation about 2

3

Fast Restraints 6
A%
ok | 7

“4 Group Names...

Clear Display of Assigns

Copy Assigns Cancel |

Figure 37: Sélectionner et Encastrer toutes les nceuds de la base

4.3.18.  Appliquer le diaphragme pour tous les planchers :

4.3.19. Sélectionner les plancher un par un tout en commengons par le 1¢
niveau (Haut RDC) jusqu’au dernier (TERRASSE)

Ohe Stary *||GLOBAL  »||KM-m -

Help

g ; Tt %0
v\ I Tmm e | v
ove Up in List | h— M

Répéter
I'étape 2 et 3
jusqu'a
attendre le
dernier
niveau

Figure 38: Diaphragme pour tous les planchers
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4.3.20.  Affecter le diaphragme D1 :

Assign  Analyze Display Design  Options  Help Assign Diaphragm
Joint/Point ) e Diaphragms... =
Erame/Line » izt Panel Zone... DiEiee Clello
Shell/Area » 1% Restraints (Supports)... 1 Add Mew Diaphragm
Joint/Point Loads 3 %,W Point Springs... tdodify/S how Diaphragm
Frame/Line Loads 4 E Link Properties...
Shell/Area Loads 3 § Additional Point Mass...
“4 Group MNames...
Clear Display of Assigns
Cancel 3
Copy Assigns . .
[~ Disconnect from All Diaphragms

Figure 39: Affecter le diaphragme

4.3.20. Veérifier le model s’il y a des erreurs de modelisation :

Al Check Model s Akl Warning ] x
Model has been checked, Mo waming messages
Line Checks
2
v JLine overaps

Apalyze Display Design Options Help

[ v JLine intersections within toleamce
Sat Anabcic Oot

Check Model... >
=¥ Run Analysis 2] Pain Checks

Poirts/Points within tolerance

o 1

v Calculate Diaphragm Centers of Rigidity

2
v |Points/Lines within tolerance
v |FPoints/Areas within tolerance /

ArzdChecks

v Jarea overlaps

ance for checks

Check loading (el stories;

; Cancel

Tal
—
v Eheck meshing for alfonies
v

' Figure 40: Affecter le diaphragme

Pour appliquer les charges, on choisit les élements ou ils sont appliquées (nceuds,
éléments linéiques, éléments surfaciques).

Pour appliquer une charge qui se retrouve sur plusieurs étages similaires, il faut
s’assurer qu’on a choisi I’option Similar Stories en bas a droite dans la fenétre
principale :

4.4.1. Une fois I’é1ément sélectionné on choisit le type de charge a appliquer (dans le
menu Assign

Assign Apalyze  Display  De

Joint/Point r

Erame/Line ]

Shell/Area C Chargement des neeuds

TomUPont Loads (ex: éﬁtlon du silg,melcl),u du ;/eln_t .,._.) ot
argement des éléments linéiques (ex : Poutre,

Frame/Line Loads r 9 q (

Shell/Area Loads poteau ...)Chargement des éléments surfaciques

Y0 Group Names... (ex : Dalle, Voile ...)
Clear Display of Assigns 22
Copy Assigns




4.4.2. Chargement du plancher terrasse (élément surfacique) par la charge Grerrasse
(choisir I’option One Story) :

Design Options  Help
| B | 34 PR e+ g | & &

-

] | i :;:| X @ JJ > %W Uniform Surface Loads
3

Load Case Name I G hd I[ KM-m hd

Uriform L Op

Load lm— (ol A5 Existing Loads
) Replacs Exising Lozd:
Diection | Gravity = £ Delete Existing Loads
.
“4 Group Names...
B ) W I ok | I 6 Cancel
Clear Display of Assigns
v

Copy Assigns

Figure 41: Chargement du plancher terrasse

e ldem pour le chargement Qterrasse :

Uniform Surface Loads

| Units
Load Case Name IQ ;I ’VIKN-m ;I
— Uniform Load O pticn:
Load I.Il— i Add to Existing Loads
DZ ® Replace Existing Loads
Direct IG'aViU’ jv " Delete Existing Loads
T 14 ool |

4.4.3. Application de la charge de Pacrotére sur la périphérie de la structure :

Frame Distributed Loads 2

Assign  Apalyze Display Design  Options Help

9
Units
’l ‘ | 34 PR o CF G | &+ | wx Load Case Name | XIS ~ | PKN'M =l
v -
” g | ] Load Type and Directi Opiarr

I ;_:;ama-f\;\na » e
|. o ’F‘;="=|x§§.

| —. & Foces 0 Homenis  Add to Existing Loads
sl peln banis @ Replacs Eristing Lods
g N : Direction | Grawity -
" Delete Existing Loads
Shellf/Area Loads 3 [:xs] 1
e Trapezoidal Load
% Group Names. = Temperature... 1 2 3 4
it -~
- T T o Pt Z Distance [0 [025 [075 I
. Open Structure Wind Parameters...
Clear Display of Assigns Lot B [ o o
Copy Assigns * Relative Distance from Endd " Absolute Distance from End
Paste Assigns 3

Uniform Logg,
Load I|15 I |I @nce\
b §

Figure 42: charge de ’acrotére
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e |dem pour le chargement des chainages (0.3 _ Gterrasse pour les chainages de
rive et 0.6 _Grerrasse pour les chainages intermediaires)

e Remagque : les éléments sélectionné si dessous ont déja été chargé sous G,
pour ajouter une autre charge sur les mémes éléments il faut sélectionl’option
« Add to existing Loads » :

Frame Distributed Loads

Urits
Load Case Name [G | [khm

Load Type and Diection Options

s @ M B 1o Erising Loads

" Freplace Existing Loads
Direction | Gravity -

" Delele Existing Loads

Trapezoidal Loads
1

2 3 4
Distance [0 Jn2s [0.75 [1
Load ] ] [o [o

# Relative Distance from End-| " Absolute Distance from End-

Uriform Load 5
Load I1aal |3 I 0K I ancel |

4.4.4. Refaire les  mémes étapesdu  chargement pour les  autres
niveaux(sélectionné I’option « Similar Stories » pour faciliter I’opération).

4.5. Chargement dynamique Table 1: spectre de reponse

u ¢ 3 | [ 1
SPECTRE DE REPONSE DE CALCUL RPA99 VERSION 2003
20NE Site

Pour le chargement dynamique (sismique) on va =% 8- & & B e e e e
adopter la méthode spectrale modale, a 1’aide de o
la feuille de calcul (excel) du spectrede réponse. T e
Q= 1.1 |Facteur de qualité Q = (1;1.05,1.10;1.15;1.20;1.25,1.3;1.35
:Z QMR1 BL Salg Sa
. 5 | ot | ioas | | . SPECTRE DE REPONSE_RPA 99

Table 2: Parameétre sismique

A= 0.15

4.5.1. Déterminer les paramétres sismique de la structure (A, T2, gf 3-15
, Q, R) voir le RPA 99 version 2003. g; =

Dans notre cas on va adopter les paramétres suivants : (;‘_) —

24 1= 0.76376262




4.5.2. Copier les 2 premiéres colonnes du tableau (voir la fig ci-dessous) et lesmets
dans un fichier texte :

Table 3: copier du tableau vers un fichier texte

14 NB:Les cellules grises sont Q= 1.25 Facteur de q { @ seemsn-Bocamm o
15 protégees, vous ne pouvez Facteur de ¢ —— N A

16 | pas les modifier. 1= 0.76376262 S oo
Tapez les valeurs de A T2 2, T e
17 [QetR i o 2

sare  SPEC | @

7 el
0.200 7 el
P

a7 el

0'180 4.76 e.e15
7 elens

0.160 a7 el
275 oleis

PR

0.140 a8 e.e1s
i e

0.120 PRE
. ssa el
S5 el

sse e

0'1[]0 4.87 e.e15
ses e

ss  ees

| a5 e
so1 elais

0.060 - 292 e.eis
25 eles

dse el

0.040 | ass el
ds  elew

| 297 el

0'020 4,98 e.e12
23 el

0.000

Sauvegarder et fermer le fichier texte.

4.5.3. Introduire le spectre (ficher texte) sur ETABS :

Response Spectrum Function Definition

Define Response Spectrum Functions

Function Diamping Ratio
/ Function Name 3 [RPa ‘ ’V [o1 —‘

| Define Draw  Select  Assign  Apalyze — Responge Spectra—— [~ Choose Function Type ta Add—/ A
v [~ Function [~ Walues are:
i FE Material Properties... S — | — |
| ?] Erame Sections. el © Frequency vs Yalue
| S WallStab/Deck Sect | i ° @ reioavsvaie
all/Slab/Deck Sections...
= = Click tor —————————————— Header Lines to ki 0

i & Link Properties... EelaliinBEE 5

Frame Nonlinear Hinge Properties.., Add New Function... | 7

Diaphragms... M odify/S how Spectum. .. | I Conver 1o User Defined || ViewFie |

| ]
= -

1 / - Function
Delete Spect |
|, / elete Spectrum
Cancel |

O Static Load Cases... ’

A
iy

ierory-Foretiore

. " R Spectr Function Definiti
Static Nonlinear/Pushover Cases... esponse Spectrum Function Hefinition

6 I Display Giaph I 0000

Add Seguential Construction Case Function Name Function D arnping Ratio
FiF#: b
B Load Combinations... { I ( —| q @ Cares
Add Default Design Combos... 7D g
Peiod  Acceleration
Conyert Combos to Nenlinear Cases...
v add | A
2| Seisrmi 0 0188
Special Seismic Load Effects... oot ~ 0184 ~ Modiy .
7 Mass § 20 e Define Response Spectrum Functions
@7 Mass Source.. 003 0178 Delet
0.04 0172 (e
005 0168
006 0164 .
lilig 018 —Response Spectra—— - Choose Function Type to &dd——
008 v |oise v
- Furction Graph I UBLCS7 Spectrum - l
 Click to:

Add Mew Function... |
todify/Show Spectrum... |
T T Delete Spectum |

Display Graph R
o
Cancsl

Cancel |

Figure 43: Introduire le spectre
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Remarque : si le message d”’erreur « Running out of memory » s’affiche,il faut

exécutez ETABS de nouveau et refaire 1’opération.

4.5.4. Définir les Cas des charges sismiques Ex et Ey :

Define Draw  Select  Assign  Apalyze
& ', Material Properties...

Ifl"]; Frame Sections...
= 2 Wall/Slab/Deck Sections...

Response Spectrum Case Data

Structural and Function D amping

Spectium Case Name EX
0.

E - . Darping 1
- ™ Link Properties...
Modal Combinali
Frame Nenlinear Hinge Properties. S (Biti(o = y
) P £t @snss MBS O GMC
Add Mew Spectrm.
. [ NewSpecir.. | i 2
Diaphragms...
Directional Combination
* 5RSS
Section Cuts... € ABS  Oithogonal SF
2 . 0K Input Response Spectra
Response Spectrum Functions... e DirerlignEugclion galeFactar
ancel
@ Time History Functions... 1 u1| N BRET I

uz h
uz hd
Excitation angle 0

Eccenticity 6
Ece. Rtio (A Disgh )

Override Diaph. Eccen. Ovveride.
Cancel

S Staticload Casesn
IR Response Spectrum Cases...

Static Nonlinear/Pushover Cases...

Add Seguential Construction Case

Response Spectrum Case Data 8

Spectrum Case Name | EY
Structural and Function Damping

Damping 0.1

Maodsl Combination
CCAC & SRSS  C ABS O GMC
no |

Directional Combination
@« 3R3S

" ABS Orthogonal $F

Input Response Spectra

Direction  Function Scale Factor

ul hd
uzl RPA - 261 I
ez | =l

Excitation angle 0.

Eceentricity

Ecc. Ratio (Al Diaph ) 0.05
Overiide Diaph. Eccen Overide...

Cancel

Figure 44: Cas des charges sismiques Ex et Ey
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4.5.5. Définir les combinaisons suivant :

0.8G+EXx
0.8G+Ey
G+Q+EX
G+Q+Ey

Define
i €. Material Properties...

Draw  Select Assign  Analyze

'EI FErame Sections...
= & Wall/Slab/Deck Secticns... -
§ N Link Properties...

Frame Nonlinear Hinge Properties...

Diaphragms...

Section Cuts...

E Response Spectrum Functions...
@ Time History Functions...

DE" Static Load Cases...
[~] Response Spectrum Cases...

Static Menlinear/Pushover Cases...

Add Seguential Construction Case

Define Load Combinations

Combinations Click. to
: Add Mew Combao...
ELS
03GEX Modify/Show Combo...
NaGEY
GOEX
GSEY Delete Combo

Cancel

kgl | oad Combinations...

Figure 45: Définir les combinaisons

4.5.6. Définir la masse source pour I’analyse modale (on choisit la source de la masse
et on ajoute les cas de charge a prendre en compte avec leurs facteursde
pondération) :

Define
§ € Material Properties...

lr"‘]; Frame Sections...
© % Wall/Slab/Deck Sections...
§ N Link Properties...

Frame Monlinear Hinge Properties...

Draw  Select Assign  Analyze

Define Mass Source
tdazz Definition

2 " From Self and Specified Mazs
@ Fiom Loads
" From Self and Specified Mazz and Loads

Diaphragms...
Diefine tase Multiplier for Loads
Section Cuts... Load Fuiltiplier
E Response Spectrum Functions... o j |U'2 :;
G 1

E Time History Functions...

| Add
J
Fadify
Delete

DE" Static Load Cases...
[~] Response Spectrum Cases...

Static Monlinear/Pushover Cases...

Add Seguential Construction Case

B | oad Combinations...

Add Default Design Combos...

Convert Cornbos to Nonlinear Cases...

| EE——

Special Seismic Load Effects...

v Include Lateral Masz Only
v Lump Lateral Mazs at Story Levels

5 Cancel

Figure 46: Définir la masse source
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4.6. Analyse et exploitation des résultats

4.6.1. Spécifier le nombre de mode (généralement le nombre de mode égal au
nombre de niveau de la structure) :

_ ‘ -Dymmc o ,—4
Number of Modes
Type of Analysis

Building Active Degrees of Freedom {* Eigenvectors ¢ Ritz Vectors

Full 30 HZ Plane YZ Plane NaoZ Rotation =
Eigen\alug Parameters

Analyze  Display Design _Options _Help /

Set Analysis Options... Frequency Shift [Center] o]
TReck TAodel Cutaff Frequency [Fadius) 0
o 1 P Relative Tolerance 1 00007
|+ RunAnalysis e = O O e (3 e i [ Incuds Riesiduskhass Modes
Dypnhamic Analysis I Set Dynamic Parameters. . / Starting Ritz Veclors
List of Loads Ritz Load Vectors
v Calculate Diaphragm Centers of Rigidity I Includs P-Delta
[~ Save Access DB File

Cancel

[
6
T e

Figure 47: Spécifier le nombre de mode

4.6.2. Lancez les analyses de la structure (bouton F5) :

Analyze Display Design  Options Help
Set Analysis Options...
Check Model

« Calculate Diaphragm Centers of Rigidity

4 ) i

Figure 48: Lancer les analyses
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4.6.3. Une fois I’analyse terminée, on peut afficher les déeformations de lastructure
pour chaque cas de charge appliqué (Il est préférable de sélectionner une Vue
d’¢élévations) :

Member Force Diagram for Frames

Load

Display Design Options  Help

{i 1 Show Undeformed Shape + | P o lomir B Component
Show Loads 3 FIEES T " Axial Farce " Torsion
L . 2

T FF Show Deformed Shape... " Shear 2-2 ™ Moment 2-2

¥ Show Mode Shape... " Shear 3-3 * Moment 3-3 H-AEWE

fsed Show Member Forces/Stress Diagram " Inplane Shear " Inplane Mament

4% Show Energy/Virtual Work Diagram... Scaling

* Auto

" Scale Factor
Options

Iv Fill Diagram

-

Show Story Response Plots...
Show Tables...

Include
v Frames [~ PFiers [ Spandrels

4 Cancel

Figure 49: afficher les déformations de la structure

4.6.4. On peut voir plus de détail sur chaque élement en le cliquons comme ci-
dessus par le bouton droite de la souris :

Diagram for Beam B21 at Story H-2EME (CH30X30)
. End Length Dffsets [Location) Display Options
U Combo I-End: | 0.150 [0.150) " Scroll for Values
JEnd | 0150 (3.350] &+ Show Max
Eguivalent Loads
1318 p— Dist Load [Down +]
i 3.18 28.8 7273
I- | | =

Moment M3
-26.808
at 3.500

Deflections
Deflection [Down +]

| End Jt: 12 JEnd JE 10 I
at 1054

" Abzalute  Relative to Beam Minimum % Relative to Beam Ends ¢ Relative ta Stary Minimum

Urits. [KN-m -

Figure 50: Voir plus de détail sur chaque élément
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4.6.5. On peut aussi exploiter les résultats d’analyse et toutes les informations de la
structure a partir des tableaux créés par ETABS, toute en choisissons les résultats
qu’on veut affichée, les cas de charges et les combinaisons.

e I 3
Displa Design Option; HE|p O MOIJEL DEFINITION (0 of 65 tables selected) =4 oS blocel st
E }r - - O Bj Select Load Cases...
O Foper ions 202 Selected
g [l Show undEfDrmEd Shape E |L: ini | nad Caes/Combos [Results
Show Loads > =5
S of 10 Laadk Selected
HIE] 0 o)
FF Show Qeformed Shape... T obtion Modi/Show Options,
0O Miscs Options
B AMALYSIS RESULTS (4 of 26 tables selected) r
ow Mode Shape... A
: O Rbacti
= Show Member Forces/Stress Diagram  » O Mol Infermation
= Bilding Dutput Select OutFul/
. . O Flame Dutput
¥ Show Energy/Virtual Work Diagram... 0 Alea Dutput o
O Opijects and Elements 5 Named Sets
Save Named Set
2 =3 |
Carcel
1 atic Loac
Clear &l -~
Show Story Response Plots... / NN o)
| T

Show Tables... / :jn’;\ ]

Figure 51: Exploiter les résultats d’analyse

4.6.6. Remarque : on utilise 1’option « Selected only » lorsqu’on veut affichée les
résultats des éléments sélectionnés sur le modele seulement.

4.6.7. On peut copier et coller les données du tableau dans un fichier Excel pour
traitement ultérieur simplement en cliquons sur le menu Edit Copy entire

Center Mass Rigidity
Edit | View
Copy Entire Table Ctrl+C Center Mass Rigidity j
Align Left MassX MassY XCM YCM CumMassX | CumMassY XCCM
P 1411323 141.1323 5.000 4500 1411323 1411323 5.000
_g i 160.5875 160.5875 5.000 4500 301.7187 301.7197 5.000
Align Right 160.5875 160.5875 5.000 4500 462.3072 462.3072 5.000
FAdENE o1 160.5875 160.5875 5.000 4500 622.8947 622.8947 5.000
H-3EME D1 160.5875 160.5875 5.000 4500 783.4821 783.4821 5.000
H-2EME D1 160.5875 160.5875 5.000 4500 944.0656 9440696 5.000
H-1ER D1 160.5875 160.5875 5.000 4500 11046570 | 11046570 5.000
ROC D1 160.5875 160.5875 5.000 4500 12652445 | 12652445 5.000
| »
I

Figure 52: Copier et coller les données du tableau

4.6.8. Maintenant a 1’aide de ces résultats vous pouvez faire les verificationsde
stabilité necessaire pour votre Project.
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4.7. Ferraillage

4.7.1. Avant de démarrer le calcul du ferrailler il faut tout d’abord changer le
reglement par défaut, puis lancer les analyses :

Options  Help
Lolors 3 Output Decimals... 1
Windows ) Steel Frame De

ncrete Frame Desi

cmposite Beam Desig
Shear Wall Design..

Set Calculator Memary...

v Show Tips at Startup

« Show Bounding Pl
S e Reinforcement Bar Sizes...

~ Moment Diagrams on Tensicn Side Live Load Reduction...

Help

|
|| v Sound

& Lock Model
Aut Save Model...

Show Aerial View Windma

Analyze Display Design  Options

Set Analysis Options...

rame Design Preferences 2

Degign Code

VI

Nurnber af Interaction Curves

Mumber of Interaction Points

1

Conszider Minimum Eccentricity Yes
Hu 0.01
Gamma [Steel] 1.15
Gamma [Concrete] 15
Pattern Live Load Factar 0.75

Utiization Factar Limit

0495 3

>| Run Analysis F5

Canicel |

4

« Calculate Diaphragm Centers of Rigidity

Figure 53: Ferraillage

4.7.2. Choisir les combinaisons correspondante au calcule du ferraillage selon le
reglement BAEL, dans notre cas, nous n‘avons besoin que de la combinaison

1.35G+1.5Q (ELU) :

Design Options Help

>||_| 4

=

I Steel Frame Design

] Concrete Frame Design

+ T Composite Beam Design

Z= Steel Joist Design 3
IE Shear Wall Design 3

Display Desi

Reset All Co

Verify Analysis vs Design Section...

g
¥ Select Design Combo...
e

1

gn Info...

ncrete Overwrites...

Design Load Combinations Selection

Chooze Combos

List af Combos

Design Load Combinations Selection

Chooge Comboz

List of Combos

_dd> |
<- Remove

6 ] ==

Deszign Combos

Dresign Combos

Figure 54: Choisir les combinaisons
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4.7.3. Démarrer le calcul du ferraillage :

Design Options Help

I Steel Frame Design b| Bl 4. 0lnr8-| ¥
@ Concrete Frame Design Select Design Combo...

+ F Composite Beam Design » 1
&8 Steel Joist Design -
E Shear Wall Dlnsies [} Start Design/Check of Structure

Display Design Info...

Verify Analysis vs Design Section...

Reset All Concrete Overwrites...

Figure 55: Calcul du ferraillage

4.7.4. Changer les unités en kN-cm (coin bas droite de la fenétre) pour que les
valeurs du ferraillage soient en cmz.
4.7.5. Exploitation des résultats du ferraillage graphiquement tout en choisironsla

B8 Gt Vi 1 Langhbnd Barfening EIROCCOL

Figure 56: Exploitation des résultats du
ferraillage graphiquement

vue en élévation pour mieux visualiser les valeurs :
Ou bien a partir des tableaux des résultats :

Choase Tables for Display

Edit
Losd Cases [Model Del |

4 [ MODEL DEFINITION (0 of 66 tables selected)
Getect Load Cases

2 of 2 Loads Selected
Load Cases/Combos [Ress]
Seloct Casas/Combos.

B of 16 Load: Selectsd

Display Design Options Help
i [l Show Undeformed Shape

Show Loads »
Madity/Show Optians:

| F7 Show Deformed Shape... .

3 ats
& 5| SULTS [0 of 26 tables selected]
£ Show Mode Shape... #01 Displacements
# O Reactions

{=4 Show Member Forces/Stress Diagram » & O Modal Information 3
& [ Building Dutput
& [ Frame Dulpust

-_/ Show Energy/Virtual Work Diagram... & O Arca Dulput
ma Hamed Sets
| SECIGH DATA 17 01 2 ables scecten)] | Selmedit

# & Concrete Frame Design

/ ?
Show Story Response Plots... 1 4

Show Tables... rm:

Figure 57: Exploitation des résultats du ferraillage a partir des tableaux des résultats
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